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Welcome to Wakanda!

Discover Wakanda as quickly as it takes for you to read this document. We will show you how to build a typical
“Employees/Companies” application by creating a model layer via datastore classes, inputting data into your
application, and displaying this data to the end-user in any browser. Building this application however does require
some basic JavaScript coding.

After a quick overview of Wakanda's architecture, we will show you how to:

Create an Employee datastore class,
Create an Interface page to display a list of employees,
Enter employees from a Web browser,
Create a Company datastore class and its Interface page,
Create a relation attribute between Employee and Company,
Import data into the datastore, and
Enhance the Interface pages to display an Employee along with his/her Company, and vice versa.

At the end of this Quick Start guide, you will have learned the fundamentals of Wakanda development. At any point
along the way, you can find more in-depth information at http://doc.wakanda.org/.

>> Download the demo application
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The Wakanda Platform

Architecture

Wakanda is a unified, end-to-end JavaScript platform for building Business Web Applications. It contains three main
parts, of which the first two are used at runtime:

Wakanda Server: A faceless application running an HTTP server on top of the object datastore engine. Data is
accessed through the powerful implementation of datastore classes and JavaScript (Server-side JavaScript,
a.k.a. SSJS).
Wakanda Application Framework (WAF): Running in the browser, this framework contains the modules and APIs
that break the barrier between the browser and the data.
Wakanda Studio: A desktop application with an Integrated Development Environment (IDE) and WYSIWYG
editors. Wakanda Studio is where you create Business Web Applications that will be launched by Wakanda
Server.

JavaScript Everywhere

One – and only one – language is used to handle the business logic in Wakanda: JavaScript.

Server-side: To create powerful business rules to handle your data. Wakanda provides JavaScript APIs to access
the file system, handle images, and manage the data (create, query, delete, etc.).
Client-side: To enhance the interface and access the data via the WAF.

System Requirements

The Wakanda platform requires the minimum following operating systems and web browsers:

Wakanda Server

Windows Vista 32-64 bit or Windows Server 2008
Mac OS X 10.6 (Snow Leopard) with a 64-bit processor machine
64-bit Linux (Wakanda Server is tested on Ubuntu 2.6)

Wakanda Studio

Windows Vista 32-64 bits or Windows Server 2008
Mac OS X 10.6

Web Browsers

Internet Explorer 9
Firefox 4
Google Chrome 11
Safari 5
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Installing and Launching Wakanda

Installation

Install Wakanda Server and Wakanda Studio onto your hard disk using the tools provided online.

You can install Wakanda Server and Wakanda Studio in different places; however, if they are side by side, Wakanda
Studio will be able to launch the server automatically. If Wakanda Studio does not find the server, it will display the
standard Open File dialog, allowing you to select a Wakanda Server to open.

Launching

Once Wakanda Server and Wakanda Studio are installed on your machine, double-click on the Wakanda Studio icon. You
don’t have to launch Wakanda Server because Wakanda Studio will automatically launch it when needed or as defined in
your settings. You can also start the server by clicking on Wakanda Studio’s Start Server toolbar button if it is not
started.

Here is the typical installation on Mac OS with Wakanda Server and Wakanda Studio in the same folder:

Here is the typical installation on Windows with Wakanda Server and Wakanda Studio in the same directory:

Wakanda's Main Window

Wakanda’s main window contains the Welcome screen because no solution has yet been opened:
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There are three main parts to Wakanda’s main window:

Toolbar: At the top of this window, the toolbar provides you with shortcuts to the actions you’ll use most often.
This toolbar can be customized, using the Display popup button:

Solution Explorer: On the left part of the studio, the “Home” tab is available by default, allowing you to create
or open an existing solution. Once you open a solution, a tab with the solution’s name will be displayed to the
right of the “Home” tab, displaying the list of elements (files and folders) in the solution. (See the “Contacts”
solution in subsequent chapters.)
Workspace Area: In this area you'll either see:

The welcome screen (as shown here) with different links to the Wakanda web site or
The opened files from the solution. Each file, when opened, is displayed in its own tab with the
appropriate editor: the Code Editor (for JS, CSS, and XML files), the GUI Designer (for Interface pages),
or the Datastore Model Designer (for the.waModel file).
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Solutions and Projects

In Wakanda, you create a project to group the different files (.html, .css, .js, .jpg, etc.) needed by your application.
Wakanda can group several projects together to be a part of one solution, managed by the server. The basic
architecture can be illustrated like this:

Wakanda Studio

     Solution

         Project A

         Project B

         …

Note: Currently, Wakanda allows you to open only one solution at a time.

Each project consists of a certain number of files, arranged in directories: Text files (HTML, JavaScript, CSS, logs, etc.)
and binary files (handled by Wakanda, such as the file that stores the data, or handled by you, such as images). Some
files have a proprietary extension but are simply XML text files (for example, .waSettings or .waModel)

We want to publish data pertaining to Employee/Company on a Web site. We therefore need to create a few datastore
classes. We’ll talk more about the datastore classes in a few moments. The description of the datastore classes is stored
in a datastore model.

At runtime, when we access the data stored in a datastore class, we will be talking about:

An entity, which is an individual entry, like one company named “4D,” and
An entity collection, which is a list of entities (e.g., “all companies in the US”).

Note: The real name for “entity” is “datastore entity”, but developers refer to it as entity.
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Creating Our First Project

To create a new project:

Choose File => New => Project in the File menu, or click the New Project... toolbar button.
In the “New Project from Template” dialog, choose the “Blank” template and click the Create button:

When the “Create File” dialog appears, select a location where you want to save the project, enter “Contacts”
for the project name, and click OK.

Because there is no existing solution, a solution with the same name will be automatically created at the top of our
project. A new "Contacts" tab is added next to the “Home” tab with the "Contacts" solution at the top, containing the
"Contacts" project:

Wakanda Studio creates all the files and folders in the Explorer (the area on the left) for each new project. We’ll
discuss these files in more detail later.
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Creating Datastore Classes

About Datastore Classes

The main purpose of datastore classes is to focus on business logic:

    Datastore class = Object + Rules

A datastore class contains one or more attributes. For example, the Employee datastore class will have a lastName and
a firstName attribute. You can also create JavaScript methods (rules) associated to the datastore class, allowing you to
initialize, validate, or calculate values, etc.

Datastore classes are at the heart of all Wakanda concepts. With Wakanda, you will dedicate part of your time defining
the datastore classes in your model. Once this is done, you will save a lot of time accessing your data and maintaining
your code. Changing a datastore class or a business rule won't require changing the Interface pages (which are HTML
files).

Creating the Employee Datastore Class

To begin, we must first open the datastore model in the Datastore Model Designer, which is a graphical tool to help us
create our datastore classes. If needed, expand the Contacts project folder to display its contents (the project's model,
settings file, WebFolder, ...). Double-click on the Contacts.waModel item in the Solution Explorer to view it with the
Datastore Model Designer in a new tab:

Note: For more information about the Datastore Model Designer, please refer to the “Datastore Model Designer”
chapter in the Wakanda Studio Reference Guide.  
To create a new datastore class, click the New Class button on the toolbar:

The new datastore class is created and displayed in the window, with a default class name, “DataClass1”, and a default
collection name (which is the class name plus the “Collection” suffix):
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Some recommendations:

The name of the datastore class should be singular,
The name of the collection that represents a list of entities should either have the “Collection” suffix, or use the
plural form: EmployeeCollection or Employees.

Note: Giving plural/singular names is semantically very important, but is not mandatory: you can give whatever valid
JavaScript name you want. But it makes reading/writing code easier, as we will see in a few moments, when we will
create the relation attribute between Employee and Company.

Enter “Employee” for the Model name. Wakanda automatically sets the collection name to “EmployeeCollection”:

 

The name of the class can also be set in the title bar: Just double-click the title bar of the datastore class to edit it.

By default, Wakanda automatically creates the ID attribute for each new datastore class. Don’t pay attention to this
attribute at this time, but don’t remove it yet.

Now we can add three attributes (with the types indicated below) to the Employee datastore class:

lastName string

firstName string

salary number

For each attribute listed above, add a new attribute to the datastore class, enter its name, and assign it a type.

To add an attribute to a datastore class:

Click the “+” button to the right of the “Attributes” heading. It adds an empty attribute with a default name,
highlighted for you to edit.

1.

Enter “lastName” to replace “attribute1” and hit the tab key. This brings you to the type column, which displays
an auto-completion array.

2.

Click “string” (selected by default) or use the keyboard arrows to select the type, and hit the return key.3.
To add another attribute, hit the return key again. The first attribute is created and a new one is added below
it.

4.
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Repeat steps 1 to 4 to create the other two attributes. For the “number” type, just enter the beginning of the name of
the type (here, “n”), use the arrow keys to select the appropriate value in the auto-completion array, and hit Return.

Once you have created the last attribute (“salary” of type “number”), a new attribute is automatically created below
“salary.” Hit the return key once more to stop creating attributes for your datastore class.

Congratulations! You just created your first datastore class!

 

Note: If you have inadvertently created an additional attribute, you can delete it by first selecting the attribute.
When you hover your cursor over the attribute, a red “X” appears on the left, allowing you to delete it.

 

Save the datastore model by clicking the Save button in the toolbar. You can also close the tab and validate the “File
has been modified, would you like to save it?” dialog.
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Creating the Employee Interface Page

After creating the Employee datastore class, we can use the GUI Designer to create an Interface page – an HTML file –
that uses the Wakanda widgets to display the data. On this Interface page, you will be able to add a few entities via the
browser. Later, we will import more employees and their companies.

From the Solution Explorer, select your project and click the New Page toolbar button:

Note: If you don’t see this button in the toolbar, click on the Display dropdown button and select New Page in the
Toolbar Content submenu.

Enter “employees” in the dialog that prompts you to name the Interface page. You don’t need to add the “.html” suffix
because Wakanda Studio does that automatically for you. As soon as you validate the dialog, Wakanda Studio creates
the file and opens it with the GUI Designer in a new tab.
Notes:

You can give the Interface page whatever name you’d like as long as it can be used as a part of a URL (and thus
displayed in a browser).
The popup menu buttons have two parts: the arrow and the button itself. When you click on the arrow, a popup
menu appears allowing you to select an option. Once you have made a choice, the next time you click on the
button, the previously selected option will be chosen by default. For example, if you chose “for Desktop,” the
next time you click on the button, Wakanda Studio will prompt you to name an Interface page for the desktop.

Wakanda created the “employees.html” file and placed it in our project’s “WebFolder”:

 

If you right-click on it and select Open Enclosing Folder from the contextual menu, Wakanda Studio opens the folder to
show you the file in the Explorer (Windows) or the Finder (Mac):
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The GUI Designer: A Quick Overview

The GUI Designer allows you to edit Interface pages in which you can include Wakanda’s powerful widgets. One of the
main strengths of Wakanda is that it breaks the barrier between the browser and the data on the server thanks to the
WAF (Wakanda Application Framework).

Now, we are going to add a Grid widget to our Interface page and bind an Employee datasource to it.

The GUI Designer is made up of four main parts:

The customizable toolbar at the top with the Design and Source buttons allow you to switch between the two
modes. Source displays the HTML code of the Interface page in the Code Editor and Design allows you to use the
GUI Designer to design your page.

1.

On the left are:
The available widgets you can drag and drop to the Designer Workspace and
The datastore classes in your model and datasources created for this Interface page.

2.

The middle area, which is currently empty, is the Designer Workspace in which you will design your Interface
page.

3.

The properties, events, and style settings for the selected widget and Interface page (if no widgets are selected)
are displayed on the right.

4.

11 28/06/2012 13:53



  

Note: For complete information about the GUI Designer, please refer to the GUI Designer chapter in the Wakanda
Studio Reference Guide.

To add a widget to your Interface page:

Select a widget,
Drag and drop it onto an empty space of the Designer Workspace, and
Bind it to a datasource.

If you'd like, you can then change the widget's properties, align it with other widgets on the Interface page, add
JavaScript code (such as adding an action to a button), and define its look on the Interface page.

Formatting the Employees Interface Page

We will create a basic page to display a list of employees, regardless of company, plus some minor formatting.

Drag and drop a Grid widget onto an empty space in the Designer Workspace.
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Drag and drop the Employee datastore class onto the Grid.

By default, the GUI Designer loads your project’s datastore model so that the datastore classes defined in your
datastore model are available as potential “datasources”. A datasource is, as its name states, a source of data, used to
fill the contents of a widget. In order to fill the grid with a list of employees, we need a datasource that is bound to the
Employee datastore class. The GUI Designer creates a datasource bound to the Employee datastore class by just
dragging and dropping it from the Model tab. By default, it gives the datasource the same name as the datastore class,
but sets the first letter to lowercase (Employee -> employee, UserAccount -> userAccount, …)

Note: A datasource represents data stored on the server, but can also represent a JavaScript variable, object, or array.
For example, you can display the contents of a JavaScript array in a Grid widget. Please refer to the GUI Designer
chapter in the Wakanda Studio Reference Guide for more information.
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After you release the datastore class onto the Grid widget:

A column is created for each of the storage attributes in the Employee datastore class.
The Model tab switches to Datasources, and a new datasource (see below for explanations about datasources) is
created, named employee (same name as the datastore class with the first letter in lowercase).

When the Grid is selected, the Properties tab (on the right) is filled with its properties. We want first to format the
interface page itself (we will format the grid in a few seconds). The Properties area, which is made up of the
Properties, Events, Skins, and Styles tabs, allows you to add a title to the Interface page, change the theme and class,
modify the background color, add an image to the background. In this Quick Start, we will show you how to change the
title for your Interface page:

Click on a blank area in the Designer Workspace to deselect the Grid. The Properties tab displays the general
properties of the Interface page. Change the title to “The Employees” (by default, the GUI Designer sets the
title to the name of the Interface page). For now, you can disregard the “RPC,” “Style sheets,” “Scripts,” etc.
areas on this tab.
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On the Skins tab, you can define a class, theme, and color palette for your Interface page. By default, the theme and
color palettes are set to “Default.” You can test out the other themes and color palettes to see how the Interface page
and widgets change. By default, widgets on the Interface page have “inherited” as their theme; therefore, they use the
Interface page’s theme.

The Styles tab allows you to modify the look of the page. You can also set the background color of the page. Click on
the “Color” button to display the color picker and choose another color if you wish. By default, the background color is
white.
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You can also set an image to the background of your Interface page. To do so, simply drag and drop the picture from
your hard disk to the Image field in the Background section.

The Interface page then appears as shown below:
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Wakanda automatically creates an “images” folder (if it wasn't already created) in the WebFolder and places a copy of
the image file in it as you can see in the Solution Explorer.

Modifying the Grid

Once you drop the Employee datastore class onto the Grid, all the class’s attributes (except relation attributes) are
added to the Grid.

You can now modify the Grid by:

Resizing it,
Removing the “ID” attribute, and
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Changing the column labels.

Select the Grid and drag one of the handles to change its height and width. You can also modify its height and width by
entering a specific value in the Styles tab.

Select the Properties tab to edit and organize the columns in the Columns area:

Remove the “ID” column by clicking on the red “X” button that appears when you hover over the “ID” attribute.
Move the “firstName” attribute above “lastName” attribute by dragging the  icon on the left to the top of

the list.

Double-click the “firstName” label and enter “First Name.” Change “lastName” to “Last Name” and “salary” to
“Salary.” The Grid now appears in the Designer Workspace as shown on the left and its properties on the right:

You can resize the columns by dragging the “resize” cursor that appears when you put your mouse over the line that
separates each header column. Drag it to the left or right to modify the width of the column.

You probably noticed that when you enter a label, a popup is displayed, allowing you to format the data in the column.
In our example, we will format the “Salary” column so that it has decimal and thousand separators. To set a format, use
the number sign (#) for each number that will be replaced only if needed, “0” for a number that well be replaced by
zero (e.g., “000” for 1 displays “001”), a comma for thousands separator and a period for decimal separator. Here is our
format:

You may also want to modify the style properties for the Grid widget. Select the Grid and go to the Styles tab where
you can change the styles for each part of the Grid: header, footer, label, even and odd rows, as well as individual
attribute header and body columns.

18 28/06/2012 13:53



 

Here, we want to change the style of the “Salary” column, so it aligned to the right:

You can also modify the background (color or image) as well as any other text styles you'd like.

In just a few minutes, you have created a simple Interface page that displays a list of all the employees in the
datastore.
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Adding Employees via the Browser

To publish the Employee Interface page (i.e., the “employees.html” file) from the GUI Designer to your default
browser, click on the Run File button.

Note: If the Interface page has been modified, it will be saved automatically before it is sent to the browser.

Clicking the Run File button leads to a couple of actions:

If Wakanda Server is not already running, it is launched.

Your default browser is launched and the employees.html page is sent to it.

Here is the result in Firefox on Windows:
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Because this is a new project, we don’t have any employees yet. To create a few employees, follow the steps below:

Click the “+” button at the bottom of the Grid:

An empty entity is created where you can insert values into each column. Enter a first name in the first cell:

Hit the tab key and enter a last name:
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Hit the tab key and enter a value in the “Salary” cell:

Hit the tab key again. Since “Salary” is the last column in the Grid, an empty entity is created in the next row
(notice how the 123456 number is correctly formatted):

Continue entering employees in the Grid. When you have have finished, click the mouse anywhere on the Interface page
to save the last one entered:
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Here are our three employees:

You can sort the data by clicking the attribute's column header in the Grid or edit a value in a cell by double-clicking on
it.

To make sure that the server has stored all your data, reload the page.
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Creating the Company Datastore Class and Interface Page

Creating the Company Datastore Class

Return to your project’s datastore model. If it is not open in a tab, double-click on “Contacts.waModel” in the Solution
Explorer.

To create a Company datastore class, follow the same steps you did when you created the Employee datastore class
with the following differences:

Enter “Company” as the Class Name and leave “CompanyCollection” as the Collection Name.

Create only one attribute: “name” of type “string.”

Save the changes to the datastore model by clicking the Save button in the Datastore Model Designer toolbar. Click the
Reload Model button as well to make sure that the modifications to the model are uploaded to the server.

Creating the Company Interface Page

On the left side of the Solution Explorer, select the project, click the New Page toolbar button. Name the file
“companies.” Wakanda Studio will create the Interface page and open it with the GUI Designer in a new tab. The Model
tab now contains two datastore classes: Company and Employee.

Drag the Grid widget and drop it to an empty space on the Interface page. Then, click on the “Model” button, and drag
Company onto the Grid. Format the Grid just like you did for the one on the “employees” HTML page: resize it, remove
the ID attribute, and set the style to your taste.

Run your page in the browser and enter two companies:
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Creating the Relation Attribute from Employee to Company

Now we will create a relation attribute between the Employee and Company datastore classes. Until now, we have only
created storage attributes. A relation attribute is a declaration that tells Wakanda: “At runtime, this employee can – if
needed – be loaded with information about the company he/she works for.”

There are two kinds of relation attributes:

N->1: In our context, it means “multiple employees work for one company.”
1->N: In our context, it means “one company has multiple employees.”

Notes: Actually, it’s not exactly one, since it is possible for a company to have no employees and for an employee to
not work for a company.
If you are familiar with the ActiveRecord pattern, you probably already recognized the classical belongs_to and
has_many pattern.

To create the N->1 relation attribute from the Employee datastore class to the Company datastore class, follow these
steps:

Open the datastore model, if it's not already open, by double-clicking on “Contacts.waModel” in the Solution
Explorer.
Move the two datastore classes so that they are side by side in the Datastore Model Designer:

Add a new attribute to the Employee datastore class.
Name this new attribute “company.”

In the type area for the attribute, type the letter “c.” As you can see, the class name and the collection name,
Company and CompanyCollection, are available as attribute types:

As we want to create a relation to one single company, we select “Company” and hit Return:
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At this point, you will notice the following:

Wakanda has drawn a relation line between the two datastore classes:

Note: If you don’t see the relation line, use the Relations dropdown button and select See All:

The company relation attribute has been created in the Employee class. Wakanda gives it the N->1 type:

Wakanda also automatically created the reverse relation attribute, “employeeCollection”, which goes from one
company to all its employees. It is of type “EmployeeCollection” and is a 1->N attribute:

We will now rename the “employeeCollection” attribute to “allEmployees.” To do so, double-click on
“employeeCollection” and change its name to “allEmployees:”

Two relation attributes have been created: N->1 and 1->N. Using the “.” (dot) notation, we can now access any
attribute in the Company datastore class when using a widget whose datasource is Employee.

For example, if you want to display the name of the company in the “employees.html” Grid:

Double-click on the “employees.html” file,
Select the Grid,
Click the  button to add a column in the Grid's Properties tab,

Enter “Works for” as its label, and
Enter “company.name” as the attribute.

The GUI Designer displays an auto-completion dropdown containing the name of the available attributes.
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Binding Employee and Company in Runtime

 At this point:

the Employee datastore class contains three entities and
the Company datastore class has two entities.

We now want to bind – from the browser – each employee to one company, using the following rules:

Employee Company

John Doe Acme

Alan Smith SuperWak

Claire Webb Acme

Creating the "Bind-Emp-Comp" Interface Page

Create a new Interface page by clicking on the New Page toolbar button. Name the file “bind-emp-comp.” Wakanda
Studio creates the new Interface page and opens it with the GUI Designer in a new tab.

Follow these steps:

Give the page a title and, if you’d like, change the default theme, color palette, and background,
Drag and drop a Grid to an empty space on the Designer Workspace,
Drag the Employee datastore class (from the Model tab) on top of the Grid, and
Format the Grid:

Remove the “ID” and “salary” attributes,
Modify the labels,
Add a column whose label is “Works For” and the attribute is “company.name”, and
Resize the Grid to view all the columns.

Create another Grid, drag and drop the Company datastore class (from the “Model” tab) on top of it, format it,
and remove the “ID” attribute. You can also resize the Grid to display the columns better, if you’d like.
Place the Employee Grid on the left and the Company Grid on the right, leaving room for a button between
them.

Note: The GUI Designer has all the alignment tools you need to align left/right/center/top/bottom/middle, and to
distribute the widgets either horizontally or vertically. Select two or more widgets by Ctrl-clicking on Windows
(Command-clicking on Mac) and use the appropriate toolbar button:
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Here is how your page should look at this point:

In this screenshot, the Employee Grid is selected so you can see the “Works For” column, which is correctly bound to
company.name. If you publish this page to your default browser (in our case, Chrome on Macintosh), it will appear as
shown below:

Because the employees are not yet bound to a company, the “Works For” column is empty.

In Wakanda Studio, drag and drop a Button widget between the two Grids:
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Double-click the button and change its title to “Bind”:

Adding JavaScript Code to the Button

While the button is selected, go to the Events tab in the Properties area and click on the  next to the “On Click"

event:

 

The first time you want to write JavaScript code for an event (either for a widget on the Interface page or the Interface
page itself), Wakanda Studio automatically does the following:

Creates a JavaScript file (whose extension is “.js”) that has the same name as the Interface page and places it in
the “scripts” folder inside the “WebFolder”:
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Modifies the HTML header of the Interface page so it knows which JavaScript file to load.
Prepares the JavaScript file so it works with the page and inserts the code used by the Wakanda Ajax Framework
at runtime.

The Code Editor opens the JavaScript file in a new tab and shows you where to write your code:

Note: For more information about the “onAfterInit” function, please refer to the Wakanda Ajax Framework
documentation.

At this point, you need to know a few things about the Wakanda Ajax Framework (WAF):

The exposed global variable sources holds all the datasources on the page. To directly access our list of
employees and companies, we write sources.employee and sources.company in the JavaScript file.
Reminder: When you dragged and dropped the Employee datastore class on the Grid, Wakanda Studio created
the employee datasource. The same is true for the Company datastore class: Wakanda Studio created the
company datasource.
Each time you select an employee or a company in the Grid by clicking on it, the corresponding entity (an
employee or a company) automatically becomes the current entity in the datasource. For example, when you
click on the “Claire Webb” row in the employees Grid, the employee datasource is updated internally so “Claire
Webb” is the currently selected employee.

For a full explanation about WAF, please refer to the reference documentation. For now, just copy and paste the
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following code in the Code Editor.

Note: After copying/pasting from this guide, you will probably need to add a few tabs to format the code properly.

// Create the association
    sources.employee.company.set( sources.company ); 
// Save the employee
    sources.employee.save();

Your JavaScript file should now look like this in the Code Editor:

Save the JavaScript file and switch to the tab containing the Interface page…

…and run it:

Binding Employees and Companies

Once the browser is open, follow these steps for each employee:

Select an employee row,
Select the company the employee works for, and
Click the Bind button.

Here are the screenshots for our three employees after we bound each one to a company:
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Importing Data (Server-Side JavaScript)

Now, we are going to import employees and companies. There are several ways into import data to the Wakanda
datastore. In our example, we are going to use a server-side JavaScript to import a text file. This file is tab-delimited
and contains the following columns:

company name -> last name -> first name -> salary

For each entry, we will search for the company in the datastore. If the company doesn’t exist, we will create it. In our
example, we will not be managing different companies with the same name. In other tutorials, you will learn how to
import a file that uses primary/foreign keys from a relational database.

First, select the “Contacts” project in the Solution Explorer and click the New JS button:

A dialog will prompt you to name the file. You don’t need to add the “.js” extension, Wakanda Studio will do that for
you automatically. Name the file “import”. Wakanda Studio creates the file, saves it to the appropriate location in your
project, and opens it with the Code Editor in a new tab.

There are four main parts in the Code Editor (two are hidden by default):

Toolbar with buttons that allow you to run the script, collapse/expand blocks, find text in the file, customize,
etc.
The code editor itself.

On the right, you can display an outline of the JavaScript code by clicking the  button. The outline

displays the structure of the code: functions, variables, etc. Clicking on an element in the outline selects the
element in the Code Editor (and jumps to it in the file if necessary).
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When you run the server-side script, an output area in the bottom part of the Code Editor window appears,
displaying the result of the script execution.

Note: Not all scripts can be run directly from the Code Editor. Typically, a JavaScript file bound to an Interface page
(HTML file) cannot be run server-side. If you click the Run File button, the JavaScript file’s Interface page will be sent
to the browser..

Here is the code for the import process that first checks to see if the entity (either company or employee) exists and
creates it if it does not. The algorithm checks for duplicate entities so if you run the script several times, it will not
recreate the same entities.

Copy and paste the code in the editor. Below, we highlight some key points of the code.

Notes:

Included with this guide is a full Wakanda solution, named “Contacts.” It contains all the data already
imported. It also contains the import file as well as the SSJS file to import the data.
If you follow the guide step-by-step, you can download the import text file from the Wakanda ftp site; once
unzipped, put the "Import" folder at the first level of your project folder (i.e. \Contacts\Contacts\Import
\emps_comps.txt).

// A simple log for the output
 var log = "Count employees-before: " + ds.Employee.length + ", Count companies-before: "

  // Main function
 function doImportEmpsAndComps () {
     /*   The doc. to import is in the solution folder, in a subfolder
         named "Import". We load the full document in one shot  (loadText) 
         and split it in an array (one line = one element).
     */
     var lines = loadText( ds.getModelFolder().path + "Import/emps_comps.txt" ).split("\n
       /*   Declare the variable that will hold the columns of each line.
           We know the columns will be:
            columns[0]   Name of the company
            columns[1]   Last name of the employee
            columns[2]   First name
            columns[3]   Salary
     */  
   var columns = [];
       // Now, loop for each entry in the array  
lines.forEach( function(oneLine) {  
      // Get the columns for current line  
columns = oneLine.split("\t");    

      // Get the company. Create it if needed.
      var theComp = ds.Company.find("name = :1", columns[0]);
      if(theComp == null) { // Not found => create it
           theComp = new ds.Company({
            name : columns[0] 
         });
         // Save it  
         theComp.save();
           }    
      // Get the employee. Create it if needed. 
       var theEmp = ds.Employee.find("lastName = :1 and firstName = :2", columns[1], colu
      if(theEmp == null) {
         theEmp = new ds.Employee( {
            lastName    : columns[1],
            firstName    : columns[2],
            salary   : columns[3],
            company   : theComp // This is how you bind two entities with Wakanda!
         }); 
      } else {
         theEmp.salary = columns[3],
         theEmp.company = theComp;
      }
        theEmp.save();
     });
 }
 // Call the function 
doImportEmpsAndComps ();
 
 // Log result

36 28/06/2012 13:53



log += " / Count employees-after: " + ds.Employee.length + ", Count companies-after: " + 

Here are some explanations and comments about this code. (All the APIs are fully documented and described in the
documentation, http://doc.wakanda.org/)

The code that parses the file expects the document to be UTF-8 encoded and to use LF as a line ending. Not
CF-LF or CR, just LF. If you change the document content or if you use a different document, make sure that the
line endings are LF. Otherwise, you will need to modify the code to handle CR or CR-LF.
loadText( ) is a high-level API that fills a string variable with the contents of a text file.
For Company and Employee, we use the find() API for parameter substitution. Instead of concatenating
columns[0] or columns[1] in the query string, we use “:1” and “:2”, which tells Wakanda Server to substitute the
1st and 2nd parameters passed after the query string. In this way, we don’t need to worry about spaces in the
names. Without this substitution, we would have to write the following with the single quotes inside the
statement:

ds.Company.find("name = '" + columns[0] + "'")

Note: This technique is also useful when you manipulate dates, non-scalar data, or more complex data types.

In the example solution provided with this guide, we use the loadText( ) method. If you work with a file that is
too large to fit into memory, it could be a good idea to use the TextStream( ) API, that reads a file line by line.
If you want to import a lot of data at once, you should set an index on the Employee.lastName,
Employee.firstName and Company.name attributes so that searching for duplicates will be faster.

Note: In our example, we are importing companies by their names. This is not the best method because different
companies could have the same name. Most of the time, you get data from a database that has Primary and Foreign
keys. Wakanda is able to import such data, but that is beyond the scope of this Quick Start guide. As a quick "how-to',
let's say that you can set the company attribute of the Employee class to the ID of a company (theEmp.company = 25;
for example, binds the current employee to a company whose ID is 25).

Once you have pasted the code in the Code Editor, hit the Run File button.

If the server is not already running, Wakanda Studio will automatically start it. Once you execute the script, the log
from our code is shown in the output area below:
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Note: Our import file contains 1,000 employees and 62 companies. We have a total of 1,003 employees and 64
companies because we created three employees and two companies earlier.

38 28/06/2012 13:53



Enhancing the Employees Interface Page

In the Creating the Employee Interface Page chapter, we created a very basic Interface page that displays a list of
employees. Now, we are going to make a few enhancements:

Modify the grid to display only the names,
Create an area that displays more information per entity, and
Add navigation buttons.

In the Solution Explorer, expand the “WebFolder” and double-click on employees.html to open it with the GUI Designer
in a new tab, and select the Grid we created previously:

Modifying the Grid

In the Properties tab, move the mouse over the “Salary” column. When the  button appears, click on it to delete

the column:

Do the same for the “Works For” column.

Reduce the width of the Grid so only the first and last names are visible.

Adding a Form to Display Employee Details

On the bottom left area of the GUI Designer, click on the “Datasources” tab and expand the employee datasource:
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Ctrl-click (Windows) or Command-click (Mac) the lastName, firstName, and salary attributes, then drag and drop them
onto an empty space on the Interface page:

When you drop the attributes in the GUI Designer, the Auto Generated Widgets dialog will ask you what kind of widgets
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you want to create for the selected attributes:

Leave the default value, “Form,” selected. Change the labels of the attributes: “lastName” to “Last Name”, etc. When
you click the Create button, the GUI Designer creates a Container widget containing a Text Input widget for each of the
attributes:

Note: For more information regarding the Container and Text Input widgets, please refer to the GUI Designer chapter
in the Wakanda Studio Reference Guide.

A Container widget holds other widgets so that when you move a Container, all the objects inside of it are moved along
with it.

In the Styles tab for the Container and Text Input widgets, you can modify how they appear on the Interface page. For
example, you can change the widget's background color, background image, border, etc. For each attribute, you can
also modify its label (font, size, and color).

Even though Wakanda allows you to change the styles for all the widgets on your Interface page, in our Quick Start
guide, we are going to leave the default formatting and instead add:

A Text widget to display the company name for which the selected employee works and
Buttons to navigate through the list of employees.

Before we begin, we will make the container taller by dragging its bottom handle down:
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Adding the Company Name

Drag and drop a Text widget into the Container:

Set its “source” to employee.company.name (the auto completion feature helps you to do this quickly).

42 28/06/2012 13:53



 

Increase the font size, center align the text, and change the border style:
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Adding Navigation Buttons

Drag and drop a Button widget into the Container:

Bind the employee datasource to this button by dragging and dropping it on top of the button:

The “Source” property of the button now shows employee:
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Select “Previous” from the “Action” dropdown menu:

Wakanda automatically sets the title of the button to “Previous,” but we want to use icons for our buttons. Wakanda
lets you set one to four icons for each button, each icon corresponding to a state of the button: default, hover, active
(mouse button is pressed), and disabled. You can set the images individually or use the same image for every state.

Open the Media Folder by clicking on the Media button and selecting Media Library:

 
The Media Library opens in the Explorer:
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Drag and drop an icon onto the Button widget:

 
Once the image file is dropped on top of the button:

The image file is copied into the “images” folder in the “WebFolder” (the “images” folder is created if
necessary).
The Button widget is resized to the size of the image.
The image is assigned to all four of the button’s states:
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You can now drag and drop another image file onto the “Hover”, “Active,” and “Disabled” states:

Now create a “Next” and a “Save” button:

Copy and paste the “Previous” button,
Modify the duplicated button by:

Setting the action to “Next”, and
Assigning an image file to the button.

Repeat the last two steps for the “Save” button.
Select the three buttons and change their positions by using the alignment tools.

Here is how the page now appears in the GUI Designer:
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Note: Due to the default theme, we also had to set the background of the buttons to transparent.

The important thing to remember is that all these widgets (one Grid, three Text Input widgets, one Text widget, and
three Button widgets) are bound to the same employee datasource. To see what this means at runtime, run the file and
test it in your browser. You will notice that:

When you click on a row in the Grid, the Text Input widgets in the container are updated with the selected
entity's values.
If you navigate the collection by clicking on the previous and next buttons, the currently selected row is
highlighted in the Grid.
If you double-click on a cell in the Grid and modify its value, it will automatically be updated in the Text Input
widget. When you leave the row, the modifications are automatically saved, which is standard behavior for a
Grid.
If you modify a value in one of the Text Input widgets, the corresponding cell in the Grid is updated; however,
the entity is not automatically saved when you navigate the entities. To save any changes made to the Text
Input widgets, you must click the Save button.
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Creating a Companies->Employees Interface Page

For our last page, we want to display a list of companies with their employees. Each time the user selects a company,
we want to display all the employees for the selected company.

Create a new Interface page and name it “comps-emps.” On this new page:

Create a Grid,1.
Bind it to the Company datastore class, as we did in previous chapters by dragging and dropping the Company
datastore class from the Model tab, which creates the company datasource.

2.

Remove the “ID” attribute so the list displays only the “name” attribute.3.

Now, add a new Grid to your Interface page. In this Grid, we want to display only the employees who work for the
currently selected company. Instead of binding the new Grid to the Employee datastore class, we will:

Expand the company datasource and
Drag and drop the allEmployees relation attribute on top of the Grid as shown below.

Now that the Grid is bound to company.allEmployees, we will format it by keeping only the first and last names, resizing
the Grid, and aligning it to the other one.  
When we run the Interface page, it appears as shown below in the browser:
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Adding Employees Automatically Related to a Company

With these two Grids defined, you can now add employees to the Employee Grid for the selected company in the
Company Grid.

To do so, click on the  icon in the Employee Grid and enter an employee: 
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Once you tab out of the Grid, the employee will be added to the datastore and Employee Grid, and it will be related to
the selected company:
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In our example, we added Lisa Rogers to the company SuperWak.
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What’s Next?

In this Quick Start guide, you have discovered many of Wakanda’s main features. Now, you can learn more about
Wakanda, datastore classes, and the Wakanda Ajax Framework through other examples.

We encourage you to read the How Do I guide in which you will learn how to:

Create new entities with JavaScript (client/server-side),
Bind widgets to JavaScript variables,
Query the datastore (client/server-side),
Use different datasources for the same datastore class,
Use datastore class methods and datastore events to code your application's business logic,
Use other kinds of attributes (calculated and alias), and
Much more.

In short, you will learn how to start developing real-world Business Web Applications using Wakanda’s powerful features.
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